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Overview 

Stellar Phoenix Database Repair for Oracle repairs data from damaged and corrupt Oracle 
10g/11g/12c databases. Using strong algorithm, the software performs a complete scan of the corrupt 
Oracle database and efficiently repairs almost every bit of information without deleting or modifying 
original data. Finally it restores repaired data to a new blank database, created by the user before 
initiating repairing process. 
 
Even heavily damaged database can be optimally repaired and restored by this software. 
 
Oracle 10g/11g/12c should be installed on the computer for successfully repairing database using 
Stellar Phoenix Database Repair for Oracle. 
 
After scanning, Stellar Phoenix Database Repair for Oracle shows the original contents of the 
selected database.  

 
What's new in this version? 
 

 Supports Oracle 12c Release 1. 

 Supports XML data type Table. 

 Supports Windows 10 / Windows 8. 

 Repairs Deleted records of Tables. 

Key Features 

 Repairs corrupt Oracle database.  

 Preview of contents of databases.  

 Supports Oracle 10g/11g/12c.  

 Repairs Index Organized Table (simple IOT).  

 Repairs Index Organized Table (Use Overflow Data Segment).  

 Repairs Nested Object type.  

 Repairs Table with Object type.  

 Repairs Table with Array type.  

 Repairs Nested Table. 

 Repairs role privilege for user.  

 Repairs system privilege for user.  

 Repairs object privilege for user.  

 Repairs role privilege for role.  

 Repairs system privilege for role.  

 Repairs object privilege for role.  

 Repairs materialized view.   

 Repairs materialized view log.  



 Repairs database link. 

 Supports XML Schema URL. 

 Supports XML table. 

 Repairs XML type Views. 

 Repairs XML indexes. 

 Repairs tables, views, table space.  

 Repairs clusters and cluster tables.  

 Repairs triggers, schemas, synonyms, roles, index, sequence.  

 Repairs primary and foreign key associated with tables.  

 Repairs user-defined data functions and stored procedures.  

 Repairs queries of database links in .txt file.  

 Allows you to store queries of objects such as, views, procedures and triggers in .txt file.  

 Allows you to store queries of functions, package and package body in .txt file.  

 Repairs packages, packages body.  

 Manual selection of databases.  

 

Limitations of Stellar Phoenix Database Repair for Oracle 

 

 Tables present in SYS schema are not repaired.  

 Compression Table & Encryption Table are not repaired.  

 User login password is not repaired.  

 Materialized view created using database link is not repaired.  

 Xml complex nested schema and based tables are not repaired. 

 Nested Array type table is not repaired. 

 Drop and truncated table data is not repaired. 
 

  



Why Stellar Phoenix Database Repair for Oracle? 

Stellar Phoenix Database Repair for Oracle has many advanced functionalities added to it. It has a 
easy-to-use user interface which enables even the naive users to operate the application. The 
application incorporates a unique and useful feature to search for databases saved in the system if the 
database path is not known. A preview of the corrupt database is also shown before repair process. 
 
Repair Oracle Database 
 
Stellar Phoenix Database Repair for Oracle is capable of repairing all the lost items of the corrupt 
Oracle database. The tool repairs corrupt database and saves the repaired data in a blank database 
created by user. The original database is left as it is. 
 
Scan Deleted Records of Tables 
 
Stellar Phoenix Database Repair for Oracle software gives an option to scan the deleted records of 
tables present in the database and repairs them. 

 
Search Database 
 
Stellar Phoenix Database Repair for Oracle software gives an option to search a drive volume to find 
out the available databases. All the databases available in that drive are shown. Any of the found 
databases can be selected for repairing. Searched databases are shown in a tabular form with all their 
details like creation date, modification date and size. These details help in locating the right database, if 
there are multiple databases created with same name. 
 
Preview Database 
 
Stellar Phoenix Database Repair for Oracle gives an option to preview the corrupt database before 
repairing it. Preview of the database shows the tables, constraints, schemas stored in the database. 
There is also an useful 'find' option given in the application to search for items in database shown in the 
preview window. User can analyze the database preview and start the repairing after being satisfied 
with the preview. Oracle software is not needed to be installed for previewing the database but Oracle 
must be installed for repairing the database. 
 

  



Installation Procedure 

Before installing the Stellar Phoenix Database Repair for Oracle software ensure that your computer 
meets the minimum system requirements and other prerequisites. 
 
Minimum System Requirements 

 Processor: Pentium Class 

 Operating System: Windows 10 / 8.1 / 8 / 7  

 Memory: Minimum 4 GB 

 Hard Disk: 50 MB of Free Space 

 Oracle: Oracle 10g/11g/12c 

 
To install the software: 
 

1. Double-click StellarPhoenixDatabaseRepairforOracle.exe file and click Run to start Setup 

Wizard. Setup - Stellar Phoenix Database Repair for Oracle dialog box is displayed. 

2. Click Next. License Agreement dialog box is displayed.   

3. Select I accept the agreement option. Click Next. Select Destination Location dialog box is 

displayed. 

4. Specify a destination in the text box or click Browse to select a destination. Click Next. Select 

Start Menu folder dialog box is displayed. 

5. Specify a destination in the text box or click Browse to select a destination. Click Next. Select 

Additional Tasks dialog box is displayed. 

6. Select the required check boxes for creating desktop icon and quick launch icon of the software. 

Click Next.  

7. In the Ready to Install dialog box, verify the settings. Click Back to make any changes, or click 

Install to install the software.  

8. After successful installation, the Completing the Stellar Phoenix Database Repair for Oracle 

Setup Wizard screen opens. Click Finish. 

  



Launching the Software 

To launch Stellar Phoenix Database Repair for Oracle in Windows 10: 

 Click Start icon -> All apps -> Stellar Phoenix Database Repair for Oracle  -> Stellar Phoenix 

Database Repair for Oracle  Or, 

 Double click Stellar Phoenix Database Repair for Oracle icon on the desktop. Or, 

 Click Stellar Phoenix Database Repair for Oracle tile on the home screen. 

To launch Stellar Phoenix Database Repair for Oracle in Windows  8.1 / 8: 

 Click Stellar Phoenix Database Repair for Oracle tile on the home screen. Or, 

 Double click Stellar Phoenix Database Repair for Oracle icon on the desktop. 

To launch Stellar Phoenix Database Repair for Oracle in Windows 7: 

 Click Start -> Programs -> Stellar Phoenix Database Repair for Oracle -> Stellar Phoenix 

Database Repair for Oracle. Or, 

 Double click Stellar Phoenix Database Repair for Oracle icon on the desktop. Or, 

 Click Stellar Phoenix Database Repair for Oracle icon in Quick Launch. 

 

  



User Interface 

Stellar Phoenix Database Repair for Oracle software has a very easy to use Graphical User Interface. 
The user interface contains features required for repairing data from damaged and corrupt Oracle 
10g/11g/12c databases. 

After launching the program, you will see the main user interface as shown below: 

 

 

The user interface contains Menus and Buttons that let you access various features of the software with 

ease. 

  



Menus 

File 
 

Open Database 
To open Oracle 10g/11g/12c database. 
 
Start Repair 
To start repairing process. 
 
Stop 
To stop an ongoing repairing process. 
 
Status Bar and Message Log 
Check/Uncheck these boxes to view or hide the 
Status Bar and Message Log. 
 
 

 

 

 
Tools 
 

Save Log 
To save the record of all processes that are 
performed by Stellar Phoenix Database Repair 
for Oracle software in a text file. 
 
Clear Log 
To clear the record of all processes that are 
performed by Stellar Phoenix Database Repair 
for Oracle software. 
 
Register 
Use this option to register the software after 
purchasing. 
 
Transfer License 
Use this option to transfer the license of the 
registered software to another computer. 
 
Update 
Use this option to check for both, latest minor and 
major versions available online. 
 

 

 

 
Help 
 



Purchase 

Use this option to buy Stellar 
Phoenix Database Repair for 
Oracle. 

Support Section 

Use this option view the support page 

of stellarinfo.com 

Knowledgebase 

Use this option to visit 

Knowledgebase articles of 

stellarinfo.com 

Submit Enquiry 

Use this option to submit enquiry to 

stellarinfo.com 

About 

Use this option to read  information 

about the software. 

Help 

Use this option to view the help 

manual for the software. 

 

 

  

https://www.stellarinfo.com/database-recovery/oracle-recovery/buy-now.php
https://www.stellarinfo.com/support/
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/
https://www.stellarinfo.com/
https://www.stellarinfo.com/support/enquiry.php
https://www.stellarinfo.com/


Tools and Buttons 

 
 
Select Database: It is present in the main screen. Use this button to select the database file from a drive 
Volume. 
 

 
 
Search Database: It is present in the main screen. Use this button to search for database files in a drive 
Volume. 
 

 
 
Scan File: It is present in the main screen. Use this button to scan the selected oracle database file for 
repairing. 
 

 
 
Connect: It is present in the repair window. Use this button to connect to a blank database for saving the 
repaired data in it. 
 
 

Toolbar Buttons 

 

 
Open database 
Use this tool to locate and open database that needs to be repaired. 

 

 
Start Repair 
To start repairing a selected database. 

 

 
Stop 
To stop database repairing process. 

 

 
Save Log 
To save the record of all processes. 
 

 

 
Clear Log 
To clear the record of all processes that are performed by Stellar Phoenix 
Database Repair for Oracle software. 
 



 

 
Register 
To register the software after purchasing. 
 

 

 
Transfer License 
To transfer the license of the registered software to another computer. 
 

 

 
Update 
To download latest updates for the Stellar Phoenix Database Repair for 
Oracle software. 
 

 

 
Purchase 
To purchase the Stellar Phoenix Database Repair for Oracle software. 

 

 

Support Section 

To view the support page of stellarinfo.com. 
 

 

 

Knowledgebase 

To visit Knowledgebase articles of stellarinfo.com. 

 

 

 

Submit Enquiry 

To submit enquiry to stellarinfo.com. 

 

 

 
About 
To read more information about the software. 

 

 
Help 
To open user guide of the Stellar Phoenix Database Repair for Oracle 
software. 

  

https://www.stellarinfo.com/
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Ordering the Software 

Click https://www.stellarinfo.com/database-recovery/oracle-recovery.php to know more about Stellar 
Phoenix Database Repair for Oracle. 

To purchase the software online, please visit https://www.stellarinfo.com/database-recovery/oracle-
recovery/buy-now.php 

Alternatively, click on Purchase icon in Help Menu on Menu Bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, a serial number will be sent to you through e-mail, which would be required 
to activate the software. 

  

https://www.stellarinfo.com/database-recovery/oracle-recovery.php
https://www.stellarinfo.com/database-recovery/oracle-recovery/buy-now.php
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Registering the Software 

The demo version is just for evaluation purpose and must be eventually registered to use the full 

functionality of the software. The software can be registered using the Registration Key which you will 

receive via email after purchasing the software.  

To register the software: 

1. Run demo version of Stellar Phoenix Database Repair for Oracle software. 

2. On Tools menu, click Register option. Register window is displayed as shown below. 

 

3. Choose ’I don’t have the registration key’ (Use this option if you have not purchased the product) 

or select ’I have the registration key’ (Use this option if you have already purchased the product). 

  

To register the software, when you do not have a registration key, follow the steps given below: 

1. In the Register window, select 'I don't have the registration key' option. Click OK, to go online 

and purchase the product. 

2. Once the order is confirmed, a Registration Key will be sent to the email provided at the time of 

purchase.  

3. In the Online Registration window, type the Registration Key and click Register button (Please 

ensure that you have an active Internet connection). 



 

4. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK.  

To register the software, when you have a key, follow the steps given below: 

1. In the Register window, select 'I have the registration key' option. 

2. You can choose either 'Online Registration' (Use this option to register the software over Internet) 

or 'Offline Registration' (Use this option to register the software manually / through e-mail if for 

any reason, Internet connection is unavailable). 

 Online Registration 

Online Registration is possible only when an active Internet connection is available. 

o To register the software online: 

1. From the Register window, select Online Registration. Click OK.  

 

2. An Online Registration dialog box will appear. 

3. Type the Registration Key (received through email after purchasing the product) in the 

field of Registration Key. Click Register. 



 

4. The software would automatically communicate with the license server to verify the 

entered key. If the key you entered is valid, software will be registered successfully. 

 Offline Registration 

Offline Registration enables you to register the product when your computer does not have an Internet 

connection. 

o To register the software offline: 

1. From the Register window, select Offline Registration. Click OK.  

 

2. An Offline Registration dialog box will appear displaying Registration ID in its 

respective field. 



 

3. To get your License Key, which is required to register the software manually, you need to 

mail the listed Registration ID to support@stellarinfo.com. 

4. A License Key will be sent to your email address after verifying the Registration ID and 

purchase details by Stellar Technical Support. 

5. After receiving the License Key, open Stellar Phoenix Database Repair for Oracle. In 

Register window, select 'I have the registration key'. 

6. Select Offline Registration and click OK. 

7. Enter the License Key received through email in the field of License Key.  

 

8. Click Register to activate the software. A confirmation message is displayed if a valid key 

is entered. Click OK. 
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Transfer License 

Stellar Phoenix Database Repair for Oracle allows you to transfer the license of the registered software 

to another computer on which you want to run the software with full functionality. This operation 

deactivates the product on your current computer so it can be reactivated on the new computer. 

To transfer a software license from one computer to another, please follow the specific steps 
below: 

On Target Computer: 

1. Run demo version of the software. 

2. In Tools Menu on Menu Bar, click Register. A new dialog appears. 

3. From the Register window, select Offline Registration. Click OK. 

4. An Offline Registration dialog box will appear displaying Registration ID in its respective field. 

 

 

On Source Computer: 

1. Run registered version of Stellar Phoenix Database Repair for Oracle software. 

2. In Tools Menu on Menu Bar, click Transfer License. 



 

3. Copy the Registration ID displayed on the Target Computer in the field of Registration ID on the 

Source Computer. 

4. To get your License Key, click Transfer In button on Source Computer. This will generate a 

License Key. 

 

5. You can also save the License Key generated on the source computer. Click Save to File button 

to save the Registration ID and the License Key. In Browse for Folder dialog box, select the 

location where you want to save the details. Click OK. 

6. ' License Key has been saved successfully ' message is displayed after the saving process is 

completed successfully. Click OK. 

This will deactivate the product on Source Computer and you will no longer be able to use the software 

anymore on this computer. 

 

On Target Computer: 



1. Type the License Key which you have generated on the Source Computer in the provided field of 

License Key. 

 

2. Click Register to complete the activation process.  

3. ' Activation Completed Successfully ' message is displayed after the process is completed 

successfully. Click OK. 

 
  



Updating the Software 

Stellar Phoenix Update Wizard helps you in keeping your application updated. Update option in the 
application is capable of checking and installing the latest updates. The wizard checks for latest minor 
and major versions available online. Minor version can be easily downloaded through the update wizard. 
However, the major version available has to be purchased. 
 
If updates are available for the product, update wizard pops up while you are running Stellar Phoenix 
Database Repair for Oracle. While updating the software, it is recommended to close all the running 
programs. 
 
To update Stellar Phoenix Database Repair for Oracle, do one of the following: 
 

 Click on update button in application tool bar. 'Update Wizard' dialog box is displayed. 

 Click Next. A busy timer shows that updates are being searched. If it finds any new version, a 

message indicates the availability. The software will start downloading the updated files from the 

server. When the process is complete, the software will upgrade to the latest version. 

 In case, a message is displayed that all latest updates has installed, click Cancel to close the 

wizard. 

 

Note: Demo version of the software cannot be updated. 

  



Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

You can either call us or go online to our support section at https://www.stellarinfo.com/support/ 

For price details and to place the order, click https://www.stellarinfo.com/database-recovery/oracle-

recovery/buy-now.php 

Chat Live with an Online technician at https://www.stellarinfo.com/ 

Search in our extensive Knowledge Base at https://www.stellarinfo.com/support/kb/ 

Submit enquiry at https://www.stellarinfo.com/support/enquiry.php 

Send e-mail to Stellar Support at support@stellarinfo.com 

Support Helpline 

Monday to Friday [ 24 Hrs. a day ] 

USA (Tollfree- Pre Sales Queries)  +1-877-778-6087 

USA (Post Sales Queries) +1-732-584-2700 

UK (Europe) +44-203-026-5337 

Australia & Asia Pacific +61-280-149-899 

Netherlands Pre & Post Sales Support +31-208-111-188 

Worldwide +91-124-432-6777 

Email Orders  orders@stellarinfo.com  

   

    

https://www.stellarinfo.com/support/
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Prerequisites for Stellar Phoenix Database Repair for 
Oracle 

Before starting the repairing process check that the following prerequisites are met. 

 

Stellar Phoenix Database Repair for Oracle - Prerequisites 

 

 Oracle 10g/11g/12c is installed on the system where repair process is to be performed. 
 

 You need to create a new blank database. This new database is used to store all repaired data of 
corrupt database. 

 

 Make sure that there are no active connections or users with the corrupt database. 
 

  



Select Database 

You can select corrupt database to be repaired in two ways: 

 

1. Browse for corrupt database and select it if you know the location of the file. To do this click 

Select Database button. 

2. Or, search for corrupt database using Stellar Phoenix Database Repair for Oracle and select 

database from the list of found databases. 

 

 

 
To search for corrupt database: 
 

 Specify drive to be searched for corrupt Database in Look In list box. 

 Click on Search Database button. 

 The application starts searching for databases in the specified drive and after the search is 
finished, displays the result as shown here, 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: Only connected databases are 

shown in the list. 
 

 Select System01.dbf file 

 Click Scan File button to start scanning process. 

 

Note: Installed Oracle application and selected oracle database to be repaired should be of the same 

version. 

  



Scan Deleted Records 

Stellar Phoenix Database Repair for Oracle provides you an option to include deleted records in 
repaired Oracle database (DBF).  

To scan deleted records follow the steps given below: 

1. Select the database by clicking on the Open Database icon from the File Menu or select the 
desired database from the list of Oracle Database files found. 

2. Select 'Scan deleted records of table' check box to preview deleted records (if found) during the 
scanning process. 

 

 
 

3. Click Scan File button to start the scanning process. 
4. After the scanning process gets completed, click Start Repair from the File Menu to start the 

repairing process. 
  



Repair Database 

After scanning, Stellar Phoenix Database Repair for Oracle lists all repaired tables in a tree view on left 
frame of software window. 
 
You can view content of tables by selecting the particular table in the tree view. You can view the status 
of other components of database (e. g. stored procedures, views, triggers, synonyms, sequence) in the 
log created while scanning the corrupt database. Log report is shown in the bottom frame of software 
window. 

To save repaired database 

 Click Start Repair button in the toolbar. A dialog box showing the steps is displayed. 

 

 

 

 Click Next. 

 A new window pops up. You need to enter the blank database name (mentioned in prerequisites) 

and its password. 

 



 

 

 Click Connect to start saving the repaired database. 

 

All repaired data of corrupt database is stored in the new database supplied by you. 

 
 
Note: 
 
You may need to repair your Oracle 10g/11g/12c database on a new system if something has gone 
wrong with the Operating System or Oracle 10g/11g/12c has developed some issues. 
 
To make your database usable, you need to prepare a new system with Oracle 10g/11g/12c installed on 
it. After this, copy database folder and paste it at a location of your preference in the newly installed 
system. 
 
Make sure that all table spaces and data related to this database is pasted in this database folder. Once 
all files are moved to this new system, you need to follow the procedure listed above. 
 

  



Access Deleted Records After Repairing Process 

Once the repairing process gets completed, you can access your table data from Command Prompt.  
 
To access deleted tables, follow the steps given below: 
 

1. Run Command Prompt. 
2. Connect to Oracle Database in which you have repaired your corrupted database. 
3. Specify the query in the syntax mentioned below for accessing the repaired table. 

 
SQL>   desc User-Name."TABLE-NAME_deleted"; 

 
For Example: If your table name is "special" and your schema name is "hr", you must write the 
query like this 
 

SQL>   desc hr."SPECIAL_deleted"; 
 

Note: Table name must be mentioned in Uppercase letters when you access the deleted tables. 
 

 
 

 
To access the database tables, follow the steps given below: 
 

1. Run Command Prompt. 
2. Connect to Oracle Database in which you have repaired your corrupted database. 
3. Specify the query in the syntax mentioned below for accessing the repaired table. 

 
SQL>   desc User-Name.Table-Name; 

 
For Example: If your table name is "special" and your schema name is "hr", you must write the 
query like this 
 

SQL>   desc hr.special; 
 



 
 
 

  



View Log Report 

Stellar Phoenix Database Repair for Oracle generates a log report of the repairing process. Log report 
helps users to analyze the repairing process in detail at a later stage. Log report shows the process start 
date and end date, time, records and items repaired in the process, etc. 
 
A log report is displayed in a frame in the application window. Save the log report to view it at a later 
stage. 
 

 To save log report, click on Tools menu and click Save Log option.   

 Clear the old log report to save a new one. To clear log report, click on Tools menu and click 
Clear Log option.  

 To view the log report, visit the location where the log report is saved in text format. 

  



Find Specific Item In Tree 

Stellar Phoenix Database Repair for Oracle gives option to find particular item(s) in tree view. After 

completion of repairing process, a search bar along with the preview window appears as shown below: 

 

To find a particular item, enter its name in Find Item text box and click Find button. If that item is present 

in the database, it is highlighted in tree. 

To narrow down the search result, you can select Match case or Match whole word check box. 

  



FAQs 

1. What does the demo version of the software do? 
 
Demo version of the software only shows the preview of the database. 
 

2. Does this software make changes to my original file? 
 

No. The software saves the repaired data in a new separate target file. The corrupt file is only read by 
the software. 
 

3. How to know whether the software will be able to repair my database or not? 
 

To know whether the software will be able to repair your corrupt Oracle database or not, please try 
the demo version of the software. Scan your file using Stellar Phoenix Database Repair for Oracle 
and preview the results for your satisfaction. 
 

4. Can Stellar Phoenix Database Repair for Oracle repair my deleted table records? 
 

Yes, the software allows you to repair all your deleted records of tables. 
 

5. Can I preview my corrupt database before saving it? 
 

Yes, you can preview the database. Preview of the database is shown after scanning of the database 
is over. 
 

6. How much time Stellar Phoenix Database Repair for Oracle will take to scan and repair the 
database? 
 

The time taken in scanning and repairing database is totally dependent upon size of the database file. 
 

7. Is Oracle needed to be installed on the system for repairing database? 
 

Yes, Oracle must be installed on the system to execute the repairing process. 

  



Possible Errors in Stellar Phoenix Database Repair for 
Oracle 

Possible Error(s) while Saving Repaired Database 
 

While saving the repaired database, you may encounter error(s). Details of these errors, their 
descriptions and how to handle them are given below: 
 

 Error ORA-12154: TNS: could not resolve the connect identifier specified. 
 
Description: This error may occur if database listener is not running or has got corrupted.  
 
Solution: In case listener is not running, start it from Services window. In case of corruption, 
create another database and then save repaired database. 
 

 Error ORA-12541: TNS: no listener.  
 
Description: This error may occur when database listener is not running. 
 
Solution: Start listener from Services window. 
 

 Error ORA-01017: Invalid username/password; logon denied. 
 
Description: This error may occur when you are providing wrong username or password. 
 
Solution: Use correct username and password. In case you have forgot, create another database 
and then save repaired database. 

  



Legal Notices 

Copyright 

Stellar Phoenix Database Repair for Oracle software, accompanied user manual and documentation 

are copyright of Stellar Information Technology Private Limited with all rights reserved. Under the 

copyright laws, this user manual cannot be reproduced in any form without the prior written permission of 

Stellar Information Technology Private Limited. No Patent Liability is assumed, however, with respect to 

the use of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 

to change without notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH 

REGARD TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY 

EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR 

ANY PARTICULAR PURPOSE WITH REGARD TO ANY OF THE FOREGOING STELLAR 

INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY FOR ANY DAMAGES 

INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL ERRORS 

OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND 

THE MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, 

BE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, 

WHETHER BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF OR IN CONNECTION 

WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR THE USE 

THEREOF. 

Trademarks 

Stellar Phoenix Database Repair for Oracle® is a registered trademark of Stellar Information 

Technology Private Limited. 

Windows 7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of Microsoft® 

Corporation Inc. 

Oracle® is a registered trademark of Oracle and/or its affiliates. 

All Trademarks Acknowledged. 



All other brands and product names are trademarks or registered trademarks of their respective 

companies. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



License Agreement - Stellar Phoenix Database Repair 
for Oracle 

Stellar Phoenix Database Repair for Oracle 

Copyright © Stellar Information Technology Private Limited. INDIA 

www.stellarinfo.com 

All rights reserved. 

All product names mentioned herein are the trademarks of their respective owners. 

This license applies to the standard-licensed version of Stellar Phoenix Database Repair for Oracle. 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 

software, unless you have a different license agreement signed by Stellar Information Technology Private 

Limited. 

If you do not agree to all of the terms and conditions of this License then do not copy, install, distribute or 

use any copy of Stellar Phoenix Database Repair for Oracle with which this License is included, you may 

return the complete package unused without requesting an activation key within 30 days after purchase 

for a full refund of your payment. 

 

The terms and conditions of this License describe the permitted use and users of each Licensed Copy of 

Stellar Phoenix Database Repair for Oracle. For purposes of this License, if you have a valid single-user 

license, you have the right to use a single Licensed Copy of Stellar Phoenix Database Repair for Oracle. 

If you or your organization has a valid multi-user license, then you or your organization has the right to 

use up to a number of Licensed Copies of Stellar Phoenix Database Repair for Oracle equal to the 

number of copies indicated in the documents issued by Stellar when granting the license. 

Scope of License 

Each Licensed Copy of Stellar Phoenix Database Repair for Oracle may either be used by a single 

person or used non-simultaneously by multiple people who use the software personally installed on a 

single workstation. This is not a concurrent use license. 

All rights of any kind in Stellar Phoenix Database Repair for Oracle, which are not expressly granted in 

this license, are entirely and exclusively reserved to and by Stellar Information Technology Private 

Limited. You shall not rent, lease, modify, translate, reverse engineer, decompile, disassemble or create 

derivative works based on Stellar Phoenix Database Repair for Oracle nor permit anyone else to do so. 

You shall not make access to Stellar Phoenix Database Repair for Oracle available to others in 

https://www.stellarinfo.com/


connection with a service bureau, application service provider or similar business nor permit anyone else 

to do so. 

Warranty Disclaimers and Liability Limitations 

Stellar Phoenix Database Repair for Oracle and all accompanying software, files, data and materials are 

distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. You 

acknowledge that good data processing procedure dictates that any program including Stellar Phoenix 

Database Repair for Oracle must be thoroughly tested with non-critical data before there is any reliance 

on it and you hereby assume the entire risk of all use of the copies of Stellar Phoenix Database Repair for 

Oracle covered by this License. This disclaimer of warranty constitutes an essential part of this License. 

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Database Repair 

for Oracle in applications or systems where its failure to perform can reasonably be expected to result in a 

significant physical injury or in loss of life. Any such use is entirely at your own risk and you would not 

hold Stellar responsible for any and all claims or losses relating to such unauthorized use. 

 

In no event shall Stellar Information Technology Private Limited or its suppliers be liable for any special, 

incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss) 

arising out of the use of or inability to use the software product or the provision of or failure to provide 

support services, even if Stellar Information Technology Private Limited has been advised of the 

possibility of such damages. In any case, Stellar Information Technology Private Limited’s entire liability 

under any provision shall be limited to the amount actually paid by you for the software product. 

General 

This License is the complete statement of the agreement between the parties on the subject matter and 

merges and supersedes all other or prior understandings, purchase orders, agreements and 

arrangements. This License shall be governed by the laws of the State of Delhi, India. Exclusive 

jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 

State of Delhi, India and you consent to such jurisdiction and venue. There are no third party beneficiaries 

of any promises, obligations or representations made by Stellar herein. Any waiver by Stellar of any 

violation of this License by you shall not constitute nor contribute to a waiver by Stellar of any other or 

future violation of the same provision or any other provision of this License. 

 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



About Stellar 

Stellar Data Recovery is a global leader in providing data recovery, data migration and data erasure 

solutions for the past two decades. Stellar Data Recovery is a customer centric, critically acclaimed, 

global data recovery, data migration & erasure solutions provider with cost effective solutions available for 

large corporates, SMEs & Home Users. Stellar Data Recovery is headquartered in New Delhi, India and 

has a strong presence across USA, Europe & Asia. 

Product line:  

Data Recovery 

A widest range of data recovery software that helps you recover your valued data lost after accidental 

format, virus problems, software malfunction, file/directory deletion, or even sabotage!. More Info >> 

File Recovery 

The most comprehensive range of file undelete and unerase software for Windows and MS office repair 

tools. More Info >> 

E-mail Recovery 

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook, MS Outlook 

Express and MS Exchange useful in instances of data loss due to damages and corruption of E-mail. 

More Info >> 

Data Protection 

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to ensure 

complete data protection against hard drive crash. More Info >> 

Data Sanitization 

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical drives, 

System Traces & Internet traces. Once the data have been removed using Stellar Wipe - Data File eraser 

utility, it is beyond recovery limits of any Data Recovery Software or utility. More Info >> 

 

Data Erasure 

https://www.stellarinfo.com/disk-recovery.htm
https://www.stellarinfo.com/undelete.htm
https://www.stellarinfo.com/mail-recovery.htm
https://www.stellarinfo.com/prevent-dataloss.htm
https://www.stellarinfo.com/prevent-dataloss.php


Stellar Data Erasure software under the brand BitRaser help businesses & consumers permanently erase 

confidential data beyond the scope of data recovery.  You can perform high speed bulk data erasure & 

generate erasure certificates for audit trail purpose. 

BitRaser supports 24 International data erasure standards. More Info >> 

 

For more information about us, please visit www.stellarinfo.com. 

http://www.stellarinfo.com/data-erasure/data-eraser-windows.php
http://www.stellarinfo.com/

